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Instruments de surveillance des eaux souterraines et des eaux de surface de haute qualité

AquaVent 5

® Hastelloy est une marque déposée de Haynes International Inc.

Options de communication flexibles de 
l’enregistreur

L’AquaVent 5 dispose d’options pour communiquer avec le 
logiciel et les accessoires Solinst, ou pour s’intégrer dans un 
système de télémétrie Solinst, un système SCADA/PLC ou un 
enregistreur de données tiers. 

L’AquaVent 5 communique avec le logiciel Levelogger et peut 
être utilisé avec l’interface App Solinst Levelogger 5 et le 
DataGrabber 5.

Pour des applications plus profondes ou plus difficiles d’accès, 
ou des applications dans des zones qui sont humides ou 
exposées aux inondations, l’enregistreur de niveau d’eau à 
pression absolue, Levelogger 5 est une option possible (voir la 
fiche technique de l’enregistreur Levelogger 5 modèle 3001). 

Caractéristiques de l’AquaVent 5
•	 Capteur de pression calibré pour des mesures du 

niveau de l’eau extrêmement précises : 0,05 % de la 
pleine échelle

•	 Renferme plusieurs filtres hydrophobes et des produits 
desséchants — pas besoin de les remplacer, entretien 
réduit

•	 Piles remplaçables par l’utilisateur, d’accès facile dans 
le puits

•	 Options pour MODBUS (RS-232/RS-485) et SDI-12
•	 Câbles séparés pour chaque protocole de 

communication
•	 Revêtement résistant à la corrosion et à l’abrasion cuit 

au four à l’aide d’une technologie de polymérisation.

Avantages de l’AquaVent 5
•	 La compensation barométrique automatique réduit le 

temps requis pour le traitement ultérieur des données
•	 S’intégrer avec les systèmes tiers  	pour la collecte de 

données à distance en temps réel
•	 Relevés de niveau d’eau fiables en continu pour les 

projets de surveillance à long terme 	surveillance 	projets
•	 Relevés de niveau d’eau réel pour résultats d’essais de 

nappe aquifère instantanés 	résultats

Enregistreur de niveau d'eau AquaVent 5
Modèle 3500

L’instrument Solinst AquaVent 5 enregistre des mesures 
précises du niveau d’eau et de la température dans des 
applications impliquant des eaux de surface ou des eaux 
souterraines peu profondes. Il combine des capteurs de 
pression et de température, des filtres hydrophobes et un 
enregistreur de données dans un boîtier en acier inoxydable de 
22 mm x 173 mm (7/8» x 6.8») avec un revêtement résistant 
à la corrosion. 

L’AquaVent 5 utilise un transducteur de pression calibré. Il est 
ouvert à l’atmosphère via un câble ventilé jusqu’à la surface. 
La pression atmosphérique est appliquée à la membrane du 
transducteur, fournissant un effet d’annulation de la pression 
barométrique. Cela produit des mesures exactes du niveau 
d’eau. 

Le câble ventilé et l’enregistreur Solinst AquaVent 5 sont 
protégés contre l’humidité par des produits desséchants et des 
filtres hydrophobes intégrés.

Le capteur de pression ventilé est en Hastelloy®, de sorte 
qu’il est extrêmement robuste et précis dans une large plage 
de températures et de conditions de surveillance. Le capteur 
assure une précision de 0,05 % de la pleine échelle et peut 
résister à 2 fois plus de pression sans dommages permanents.

La mémoire robuste peut contenir jusqu’à 150 000 ensembles 
de données lorsqu’elle est programmée dans le logiciel Solinst 
Levelogger®.

Applications de l’AquaVent 5
•	 L’AquaVent est parfait pour les applications 

impliquant une 	immersion jusqu’à 20 m (65 po)
•	 Caractérisation des aquifères : essais de pompage, 

essais de puits, etc. 
•	 Jaugeage d’un cours d’eau, gestion d’un lac ou d’un 

bassin de retenue
•	 Surveillance d’une ligne de partage des eaux, d’un 

bassin d’évacuation ou d’un bassin de recharge
•	 Surveillance des eaux pluviales et du ruissellement
•	 Surveillance à long terme du niveau d’eau de puits ou 

d’eaux de surface

Plus d'informations | Mode d'emploi | Obtenir un devis 

https://www.solinst.com/francais/produits/enregistreurs-de-donnees-et-de-telemetrie/3500-aquavent/fiche-technique/01-fiche-technique.php?utm_source=solinst-&utm_medium=DS-&utm_campaign=3500-WC-&utm_term=DT-global-&utm_content=DS-FR-3500-moreinfo
https://www.solinst.com/francais/produits/enregistreurs-de-donnees-et-de-telemetrie/3500-aquavent/get-quote.php?utm_source=solinst-&utm_medium=DS-&utm_campaign=3500-WC-&utm_term=DT-global-&utm_content=DS-FR-3500-getquote
https://www.solinst.com/francais/produits/enregistreurs-de-donnees-et-de-telemetrie/3001-serie-levelogger/levelogger/fiche-technique/01-fiche-technique.php?utm_source=solinst-&utm_medium=DS-&utm_campaign=3001-WC-&utm_term=DT-global-&utm_content=DS-FR-3500-3001
https://www.solinst.com/francais/produits/enregistreurs-de-donnees-et-de-telemetrie/3500-aquavent/instructions/instructions.php?utm_source=solinst-&utm_medium=DS-&utm_campaign=3500-WC-&utm_term=DT-global-&utm_content=DS-FR-3500-ins
https://www.solinst.com/francais/produits/enregistreurs-de-donnees-et-de-telemetrie/3500-aquavent/get-quote.php?utm_source=solinst-&utm_medium=DS-&utm_campaign=3500-WC-&utm_term=DT-global-&utm_content=DS-FR-3500-getquote
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Tête de puits de communication AquaVent 5
Les têtes de puits de communication AquaVent 5 Wellhead s’adaptent parfaitement sur un 
tubage de puits de 5 cm (2 pouces) muni d’une base pour tête de puits (un adaptateur de 10 cm 
(4 pouces) est disponible). 

La tête de puits SPX dispose d'une connexion pour communiquer avec le logiciel et les 
accessoires Solinst, et d'une seconde connexion pour communiquer avec des enregistreurs de 
données ou des systèmes de télémétrie tiers utilisant les protocoles MODBUS (RS-232/RS-
485) ou SDI-12. 

Chaque tête de puits contient 4 piles au lithium AA de 1,5 V qui alimentent l'enregistreur 
AquaVent 5. Ils sont remplaçables par l'utilisateur et peuvent durer 8 ans sur la base d'une 
lecture par minute (la batterie interne de l'enregistreur AquaVent 5 n'est utilisée que pour 
maintenir l'horloge). 

Pour une protection permanente contre l’humidité, les têtes de puits Wellhead renferment des 
produits desséchants et un filtre hydrophobe là où le câble ventilé se termine au niveau de la 
surface.

Câbles de communication de tête de puits AquaVent
Il existe plusieurs façons de communiquer avec l’AquaVent ; des câbles de têtes de puits adaptés 
sont disponibles pour chaque option. 

Options de câbles ventilés AquaVent 5
Des dispositifs de câbles ventilés AquaVent 5 sont disponibles dans des longueurs allant jusqu’à 
500 pieds.

Les câbles ventilés comportent des fils d’alimentation électrique et des fils de communication, 
ainsi qu’un tube de ventilation sur toute la longueur du câble. Les câbles ventilés fournissent une 
communication directe entre l’enregistreur AquaVent 5 et la tête de puits. Le tube de ventilation 
et les fils sont enrobés dans une gaine en polyuréthane offrant durabilité et protection.

Les câbles ventilés se raccordent de manière simple et efficace à l’enregistreur AquaVent 5 et à 
la tête de puits Wellhead à l’aide de raccords rotatifs. Un support de suspension est fourni avec 
chaque tête de puits Wellhead, afin de soutenir le câble ventilé. 

Tête de puits SPX

Câble de connexion USB pour la 
communication avec le logiciel 

pour PC Solinst Levelogger 

Câble de connexion pour 
la communication avec 

l’interface App Levelogger et 
DataGrabber.

Câbles de connexion pour les 
communications basées sur les protocoles 

SDI-12 et MODBUS sur RS-232/RS-485

Raccord à 10 broches 
pour le branchement 

des câbles de connexion 
des logiciels et des 
accessoires Solinst

Raccord supplémentaire 
à 12 broches pour câbles 
de connecteur SDI-12 et 
MODBUS sur RS-232 et 

RS-485

Têtes de puits 
AquaVent 5 SPX

Dispositif de câble 
ventilé

Support de 
suspension

Enregistreur 
AquaVent 5

Base pour tête 
de puits
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Configuration de l’AquaVent 5 à l’aide du 
logiciel de Solinst
Lors de la programmation à l’aide du logiciel Levelogger, utilisez 
un câble de connexion USB pour raccorder la tête de puits 
AquaVent 5 Wellhead à l’ordinateur.( Il est également possible 
de programmer L'AquaVent 5 peut également être programmé 
à l'aide de l'application Solinst Levelogger sur votre appareil 
intelligent.)

Le logiciel Levelogger est très intuitif. Il détecte automatiquement 
le type d’enregistreur raccordé. Remplissez les informations 
de votre projet et le régime d’échantillonnage, le tout sur un 
seul écran. Les paramètres peuvent être sauvegardés pour 
une réutilisation plus aisée. Des options sont offertes pour un 
démarrage/arrêt immédiat ou programmé. 

Il est possible de synchroniser l’horloge de l’AquaVent 5 temps 
avec celle de l’ordinateur. La charge de la pile (pourcentage) 
dans la tête de puits Wellhead et la quantité de mémoire libre 
dans l’enregistreur sont indiquées. 

Options d’échantillonnage pratiques
Il est possible de programmer l’AquaVent 5 pour qu’il mette 
œuvre un échantillonnage linéaire, basé sur des événements 
ou programmé par l’utilisateur. L’échantillonnage linéaire peut 
être réglé de 1/8 de seconde à 99 heures, avec un stockage en 
mémoire jusqu’à 150 000 ensembles de données. 

Il est possible de configurer l’échantillonnage basé sur des 
événements de manière à enregistrer le niveau lorsqu’il varie 
par un seuil choisi. Les mesures sont vérifiées à la fréquence 
de temps sélectionnée, mais sont seulement enregistrées dans 
la mémoire si la condition est remplie. Par défaut, une mesure 
est enregistrée toutes les 24 heures si aucun événement ne se 
produit.  

L’option de programmation permet de définir jusqu’à 30 
événements, chacun avec sa propre fréquence d’échantillonnage 
et sa propre durée. Pour plus de commodité, il existe une option 
permettant de répéter automatiquement la programmation. 

Téléchargement, visualisation et exportation 
de données
Il est possible de télécharger les données sur un PC par un 
simple clic sur une icône à l’écran. De nombreuses options sont 
offertes pour le téléchargement de données, y compris « Append 
Data» (Ajouter les données) et « All Data » (Toutes les données). 
Le logiciel permet également de visualiser immédiatement les 
données sous forme graphique ou tabulaire en utilisant « Real 
Time View » (Visualisation en temps réel). 

Les données de niveau sont automatiquement compensées pour 
la température ; les données de température sont également 
téléchargées. Il est possible d’utiliser l’Assistant des données 
pour saisir des ajustements manuels des données, l’altitude, des 
décalages ou la densité du liquide. 

Le logiciel permet d’exporter facilement des données dans 
un tableur ou dans une base de données pour les traiter 
ultérieurement.

L’App Solinst Levelogger vous permet également de visualiser 
et de sauvegarder des données en temps réel ou des données 
enregistrées sur votre appareil intelligent.

Utilitaires pratiques
En cas d’un problème inattendu, il est possible d’utiliser « Self-
Test Diagnostic Utility » (utilitaire d’autodiagnostic). Cet utilitaire 
vérifie le fonctionnement du programme, l’étalonnage, les 
mémoires de sauvegarde et d’enregistrement, le transducteur 
de pression, le capteur de température et la tension de la pile, 
ainsi que l’activation d’un vidage complet de la mémoire, le cas 
échéant.  

Une mise à jour de la version du capteur (microprogramme) 
sera périodiquement disponible pour permettre la mise à jour 
de  l’AquaVent 5, à mesure que de nouvelles fonctionnalités 
sont ajoutées.

L’interface App Levelogger 5 utilise la technologie Bluetooth® tpour connecter l’AquaVent 5 à votre 
appareil intelligent. Avec l’App Solinst Levelogger, vous pouvez télécharger des données, afficher des 
données en temps réel et programmer votre AquaVent 5. Vous pouvez envoyer les données par courrier 
électronique directement de votre appareil intelligent à votre bureau (voir les fiches techniques du modèle 
3001 Levelogger 5 App Interface).

App Levelogger et interface App Levelogger 5

®Apple et le logo Apple sont des marques d’Apple Inc., déposées aux États-Unis et dans d’autres pays. App Store est une marque de service 
d’Apple Inc. Google Play est une marque commerciale de Google Inc. 
La marque et les logos Bluetooth ® sont des marques déposées de Bluetooth SIG, Inc. et toute utilisation de ces marques par Solinst Canada Ltd. 
est sous licence. 

https://itunes.apple.com/us/app/solinst/id854408232
https://play.google.com/store/apps/details?id=com.solinst.solinstandroidapp&hl=en
https://www.solinst.com/francais/produits/enregistreurs-de-donnees-et-de-telemetrie/3001-serie-levelogger/interface-app-levelogger/fiche-technique/01-apple-fiche-technique.php?utm_source=solinst-&utm_medium=DS-&utm_campaign=3001appint-WC-&utm_term=DT-global-&utm_content=DS-FR-3500-3001appint
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Spécifications de l'enregistreur AquaVent 5
Capteur de niveau : Silicium piézorésistif avec capteur en Hastelloy

Précision : Typiquement ±0,05 % de la pleine échelle 

Stabilité des mesures : Excellente, bruit faible

Unités de mesure: m, cm, pi, psi, kPa, bar, ºC, ºF

Résolution: 0.001% à 0.0006% de la pleine échelle

Normalisation: Compensation automatique de la température

Plage de comp. de temp 0º à 50ºC

Capteur de température: Thermomètre à résistance de platine (RTD)

Température de 
fonctionnement :

-20ºC à 80ºC

Précision du capteur de 
temp. :

± 0,05 ºC

Résolution du capteur de 
temp :

0.003°C

Autonomie des piles : 8 ans en se basant sur 1 relevé par minute

Précision de l’horloge 
(typique) :

±1 minute/an (à des températures comprises 
entre -20 et 80 °C)

Nombre maximal de 
relevés :

150 000 ensembles de données.

Mémoire : Continue et de réserve 

Communication : Solinst USB 57,600 bit/s, SDI-12 1200 bauds, 
Modbus RS-485/RS-232 (débits divers)

Taille: 22 mm x 173 mm (7/8 x 6,8 po) 

Poids: 190 grammes (6,7 onces)

Résistance à la corrosion: Revêtement cuit au four utilisant la technologie 
de polymérisation (intérieur et extérieur)

Matériaux mouillés : Delrin®, Viton®, polyuréthane (botte TPU), acier 
inoxydable 316L, Hastelloy, revêtement PTFE 
sans PFAS

Modes d’échantillonnage : Linéaire, programmé par l’utilisateur ou basé 
sur des événements avec mode répétition, 
démarrage programmé, arrêt programmé, 
affichage en temps réel

Fréquence des mesures : 1/8 s à 99 heures

Compensation 
barométrique :

Automatique

Modèles Pleine échelle (FS) Précision Résolution

M5 5 m (16.4 ft.) ± 0,3 cm (0,010 pi) 0,001% FS

M10 10 m (32.8 ft.) ± 0,5 cm (0,016 pi) 0,0006 % FS

M20  20 m (65.6 ft) ± 1 cm (0,032 pi) 0,0006 % FS

DataGrabber 5
Le DataGrabber 5 est un dispositif de 
transfert de données prêt à l’emploi qui 
vous permet de copier les données d’un 
AquaVent 5 sur une clé USB, en appuyant 
sur un seul bouton (double clé USB & 
USB-C fournie). Le DataGrabber 5 est 
compact et très facile à transporter.

Têtes de puits AquaVent 5 SPX
Matériaux: Polypropylène, Delrin, Inox 316, Viton, 

Polyamide 

Dimensions: 102 mm x 140 mm (4,0 x 5,5po)

Température de 
fonctionnement :

-20ºC à 80ºC

Classe de protection IP : IP64 (résistantes à la poussière et aux 
éclaboussures)

Piles: Quatre (4) piles AA au lithium

Longueur du câble de 
communication de la tête 
de puits :

4.5 m (15 ft)

Câble ventilé de l'AquaVent 5 
Matériaux mouillés : Polyuréthane, Laiton nickelé, Viton

Diamètre: Câble : 8 mm (0,32po) Connecteurs : 20 mm 
(0,79po)

Longueurs : 1 à 500 pi

Rayon de courbure max. : 25 mm (1po)

Température de 
fonctionnement :

-20ºC à 80ºC

Unité de lecture Solinst (SRU)
Connectez une SRU à un AquaVent 
5 sur le terrain à l'aide d'un câble de 
communication de tête de puits pour 
afficher les relevés de niveau d'eau 
instantanés et l'état de l'enregistreur 
de données, enregistrer une session 
d'enregistrement en temps réel et 
télécharger les données dans la 
mémoire de la SRU.

https://www.solinst.com?utm_source=solinst-&utm_medium=DS-&utm_campaign=3500-WC-&utm_term=DT-global-&utm_content=DS-FR-3500-footerhome
mailto:instruments%40solinst.com?subject=

